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Foreword

 

• This manual contains text, disgrams and explanations which will guide the reader in the cor-
rect programming and opration of the PneuAlpha series controller.

• Before attempting to install or use the PneuAlpha series controller this manual should be read 
and understood.

• If in doubt at any stage of the installation of the PneuAlpha series controller always consult a 
professional electrical engineer who is qualified and trained to the local and national standards 
which apply to the installation site.

• If in doubt about the operation or use of the PneuAlpha series controller please consult the 
nearest SMC Pneumatics Regional Centre.

• This manual is subject to change without notice.
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FAX BACK

SMC Pneumatics has a world wide reputation for its efforts in continually developing and push-
ing back the frontiers of industrial automation. What is sometimes overlooked by the user is
the care and attention to detail that is taken with the documentation. However,to continue this
process of improvement, the comments of the SMC users are always welcomed. This page
has been designed for you,the reader,to fill in your comments and fax them back to us. We
look forward to hearing from you.

Fax numbers: Your name....................................................

SMC Pneumatics.... .....................................................................

America 317-899-3102   Your company ..............................................

Australia 9894-5719   .....................................................................

Germany 06103-402139    Your location: ...............................................    

United Kingdom 01908 561185

Please tick the box of your choice

What condition did the manual arrive in?

 

!

 

Good

 

!

 

Minor damage

 

!

 

Unusable

Will you be using a folder to store the manual?

 

!

 

Yes

 

!

 

No

What do you think to the manual presentation?

 

!

 

Tidy

 

!

 

Un-friendly

Are the explanations understandable?

 

!

 

Yes

 

!

 

Not too bad

 

!

 

Unusable

Which explanation was most difficult to understand: ..................................................................
....................................................................................................................................................

Are there any diagrams which are not clear?

 

!

 

Yes

 

!

 

No

If so,which:..................................................................................................................................

What do you think to the manual layout?

 

!

 

Good

 

!

 

Not too bad

 

!

 

Un-helpful

If there one thing you would like to see improved,what is it?......................................................
....................................................................................................................................................
....................................................................................................................................................

Could you find the information you required easily using the index and/or the contents,if possi-
ble please identify your experience: ...........................................................................................
....................................................................................................................................................
....................................................................................................................................................
....................................................................................................................................................
....................................................................................................................................................

Do you have any comments in general about the SMC manuals?.............................................
....................................................................................................................................................
....................................................................................................................................................
....................................................................................................................................................
....................................................................................................................................................

Thank you for taking the time to fill out this questionnaire. We hope you found both the 

 

product
and this manual easy to use.
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Guidelines for the safety of the user and protection of ECC-PNAL-PCS/WIN-E

 

This manual provides information for the use of ECC-PNAL-PCS/WIN-E. The manual has
been written to be used by trained and competent personnel. The definition of such a person
or persons is as follows;

a ) Any engineer who is responsible for the planning, design and construction of automatic
equipment using the product associated with this manual should be of a competent
nature,trained and qualified to the local and national standards required to fulfill that
role. These engineers should be fully aware of all aspects of safety with regards to auto-
mated equipment.

b ) Any commissioning or service engineer must be of a competent nature,trained and
qualified to the local and national standards required to fulfill that job. These engineers
should also be trained in the use and maintenance of the completed product. This
includes being completely familiar with all associated documentation for the said prod-
uct. All maintenance should be carried out in accordance with established safety prac-
tices.

c ) All operators of the completed equipment should be trained to use that product in a safe
and co-ordinated manner in compliance to established safety practices. The operators
should also be familiar with documentation which is connected with the actual operation
of the completed equipment. 

 

Note :

 

 the term ‘completed equipment’ refers to a third party constructed device which con-
tains or uses the product associated with this manual.

 

Notes on the symbology used in this manual

 

At various times through out this manual certain symbols will be used to highlight points of
information which are intended to ensure the users personal safety and protect the integrity of
equipment. Whenever any of the following symbols are encountered its associated note must
be read and understood. Each of the symbols used will now be listed with a brief description of
its meaning.

 

Hardware warnings

 

1 ) Indicates that the identified danger

 

 WILL

 

 cause physical and property damage.

2 ) Indicates that the identified danger could 

 

POSSIBLY

 

 cause physical and property
damage.

3 ) Indicates a point of further interest or further explanation.

 

Software warning

 

4 ) Indicates special care must be taken when using this element of software.

5 ) Indicates a special point which the user of the associate software element should
be aware of.

6 ) Indicates a point of interest or further explanation.
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1. Introduction

 

This section describes the major functions of the ECC-PNAL-PCS/WIN-E software and the
Outline of this manual. Make sure to read this section before using the software.

 

1.1 Outline

 

The software package ECC-PNAL-PCS/WIN-E  is a programming tool designed to be used
with the PneuAlpha Simple Application Controllers. The SMC VLS software runs on Microsoft
Windows Versions 95 and NT (hereafter referred to collectively as Windows). The software has
been designed to be both powerful and user friendly. While many of the software features can
be learned intuitively, a detailed help file has been incorporated into the software to help users
find answers to their questions.

 

1.1.1 List of Models Compatible with the SMC VLS software

 

The ECC-PNAL-PCS/WIN-E software is compatible with all of the PneuAlpha Series Control-
lers. Current models  and models scheduled for release in 1999 include; ECC-PNAL-6MR-A,
ECC-PNAL-10MR-A, ECC-PNAL-10MR-D, ECC-PNAL-10MT-D, ECC-PNAL-20MR-A, ECC-
PNAL-20MR-D, and ECC-PNAL-20MT-D.

 

1.1.2 Product Configuration

 

Check the contents of the ECC-PNAL-PCS/WIN-E box against this list to confirm that the fol-
lowing   accessories are supplied.

PneuAlpha programming software freely available with no charge from the SMC web site:
www.smcpneumatics.co.uk

Manual (this manual) ECC-PNALSOFT-B

 

1.1.3 Major Features of the ECC-PNAL-PCS/WIN-E  Software

 

The ECC-PNAL-PCS/WIN-E  is a powerful tool for programming the PneuAlpha Simple Appli-
cation Controller in Function Block style. The Visual Nature of the software helps the user to
see and understand the relationships between all parts of the program. Powerful and easy to
use, the SMC VLS software has incorporated the following features for your convenience:

Normal Windows based software functions

Full range of pull down menus with premade icons

Mouse Access to Most Features

The Auto Wizard for Beginning Users

System Sketch Capabilities to add your Own Icons

Simulation Capability for Program Debugging

Run Time Monitor

Personal Computer or Modem hookups
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1.2 Definitions

 

The following terms will be used throughout this manual and the ECC-PNAL-PCS/WIN-E soft-
ware.

Function Block Programming - The method by which the PneuAlpha Simple Application Con-
troller is programmed. 

Function Blocks - the heart of the PneuAlpha controller. They process information received
from inputs or other sources, manipulate the data, and control the system Outputs. There are
22 function blocks that can be found in the Accessories Toolbar under the FUNC or LOGIC
headings. The function blocks have been pre-programmed to perform specific actions and may
have variable parameters that can be adjusted for specific programming needs.

Function Block Diagram base (FBD base) - All system program components (Inputs, Outputs,
Function Blocks, Memory Bits, or Keys) are placed on the FBD base during programming.

Digital - A type of Input or Output that only recognizes an On or Off state. An On state can also
be referred to as “High” or “1” while the Off state can be referred to as “Low” or “0”.

Analog - A type of input/output that gives a numeric value in either Volts or Amperes. 

 

1.3 Abbreviations

 

The following definitions or abbreviations will be used throughout this manual.

The ECC-PNAL-PCS/WIN-E software will be referred to as VLS software.

The PneuAlpha Simple Application Controller may be referred to as the controller or the
PneuAlpha

 

 

 

controller.

Function Blocks may be referred to as FB(s).

Input/Output may be referred to as I/O.
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2. Installation

 

This section describes how to install the ECC-PNAL-PCS/WIN-E software package and to
connect the PneuAlpha Simple Application Controller to the Personal computer. The Operation
System requirements are outlined and the equipment necessary to make all proper connec-
tions are detailed.

 

2.1 Operating System Requirements

 

The ECC-PNAL-PCS/WIN-E software is designed to be installed on a computer that meets or
exceeds the following specifications. Please check whether your personal computer meets
these requirements prior to the software installation.

 

2.2 Installation

 

Install SMC VLS Software downloaded from the SMC Website: www.smcpneumatics.co.uk

Perform installation in accordance with the Wizard. The procedure is equivalent to that for gen-
eral Windows applications.

 

2.3 Uninstallation

 

To uninstall the ECC-PNAL-PCS/WIN-E software, click the [Install/Uninstall] option in the
“My Computer:\Control Panel:\Add/Remove Programs”. 

Delete “Pneu Alpha Visual Logic-E”.

Table: Personal Computer Requirements

Item

Operating System Microsoft Windows 95 or Windows NT 4.0

CPU Pentium 133 MHz or more (recommended)

Hard Disk 10 MB of free capacity

Memory 32 MB or more (recommended)

Floppy Disk Drive 1.44 MB (Required for Setup)

Pointing Device Mouse or other pointing device

Video SVGA (800 x 600) 256 colors or more (recommended)
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2.4 System Configuration

 

The system configuration for the Personal Computer and PneuAlpha controller is diagrammed
below. Please check for proper connections before transferring programs between the control-
ler and the PLC. The Communications port for program transfer between the personal com-
puter and the PneuAlpha controller can be designated in the COM pull down Menu in the SMC
VLS software.

Program transfer via Modem can also be accomplished; use the ModemInit command in the
COM Menu to setup the modem.

Computer

Modem

ECC-PNAL-
232CAB(Option)

α PneuAlpha
controller
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3. Using the Help Files

 

The VLS software includes a powerful package of help files to guide the user through the pro-
gramming options. Use the F1 key, click the help icon, or use the Help pull down menu to
access the help files.

 

3.1 The F1 Key

 

The F1 key will provide specific help on a highlighted object. 

Click a system component on the FBD base to highlight it and press the F1 Key to bring up a
dialog screen.   To receive Help on a command, move to the command with the mouse until
the instruction is highlighted in blue. Type F1 to access the Help dialog box before using the
command.

 

3.2  The Context Help 

 

The Context Help command can provide help with Tool Bars and associated commands.
When you choose the Toolbar's Context Help button, the mouse pointer will change to an
arrow and question mark. Then click on the item needing clarification in the VLS window. The
Help topic will be shown for the item you clicked.

Key operation : Shift+F1

 

3.3 The Help Pull Down Menu

 

The Help pull down menu provides answers a variety of ways.
Upon entering the Help menu the options list will be shown.

When “Contents”, “Search for Help On...”, or “How to Use
Help...” is chosen, three tabs will appear on top of the win-
dow.  These tabs can be used in addition to the Help files
available on the display.
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3.3.1 The Contents Command or Tab

 

The contents menu allows the user to choose from the following categories or chapters

 

  

 

Introduction - Choose from a basic introduction, information on the FBD base, or the System
Sketch Operations.

Menu Options - Choose to view detailed information upon each pull down menu available at
the top of the screen.

Functions and Signals - Learn about the functions and capabilities of the Inputs, Outputs, and
Function Blocks available for programming with the SMC VLS package.

Various Modes of Operation - Explains about the different modes of operation including the
Programming mode, the Simulation Mode, and the Monitoring Mode.

Special Features - This section describes the various ways of Dragging and Dropping objects,
and of Moving Objects with the arrow keys.

Help Support - Provides information on using the Contents Help icon, F1 key, and help dialog
boxes.

When an option is chosen, the main topics available for that category pop up on screen.
Choose the desired topic to bring up a dialog box.

 

Words or phrases that are highlighted in green contain addition information in another dialog
box. Click on the highlighted text to view its dialog box.
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3.3.2 The Index Tab

 

The Index tab displays information about topics displayed in the index. Type the first few letters
of the required topic or scroll to the topic in the index list. 

 

3.3.3 The Find Tab

 

The Find Tab generates a list of key SMC VLS words and lets you search for help on those
words. A matching words directory gives an option to narrow the number of matches found. A
third directory lists the topics in which your word appears.

 

3.3.4 Search for Help On ...

 

Click on the “Search for Help On” option to bring up the opening Help window. Click on the
desired category to bring up information and instructions for using SMC VLS or various pieces
of reference information.

 

3.3.5 How to Use Help

 

Gives detailed information on how to Use Help and Customize the Help settings for the users
convenience. Topics include finding, copying, viewing, and printing help files and manipulating
the data in dialog boxes. Learn how to change the color or font size of a dialog box, add com-
ments, or bookmark especially useful information.

 

3.3.6 About SMC VLS

 

Use this command to display the copyright notice and version number of your copy of SMC
VLS.
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4.  What You Should Know Before Starting to Program

 

This section describes the basic functions and background information necessary to the
proper operation of the SMC VLS software. Please read and understand this section prior to
beginning your first program.

There are two screens that can be accessed from the VLS software, the Function Block Dia-
gram base (FBD base) and the System Sketch Monitoring screen.

 

4.1 Screen Identification

 

The Toolbars have been labeled on the screen below for the users reference. These Tool bars
can be turned On or Off in the View menu. The Menu Bar runs across the top of the screen.
The two main viewing screens will be discussed later in the chapter.
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4.2 The Function Block Diagram base

 

The Function Block Diagram (FBD) base provides the platform upon which the program for the
PneuAlpha controller is constructed. The FBD base consists of a large wiring area (green by
default), a title box and input and output rectangles vertically along the right and left hand
sides, respectively. Programming components are placed on the wiring area or in the rectan-
gles, and connected by wires to construct the controller program. The FBD base is also known
as FBD Wiring area..

The user can perform the following ten operations using FBD base screen. Refer to Chapter
Six for more details.

1. Place the I/O signals and functions using Accessories Tool bar.

2. Assign parameters to functions.

3. Wire the various program components together (with the help of Wiring Analyser).

4. Load the Program logic and I/O device’s information to the PneuAlpha Controller.

5. Invoke Auto FBD Wizard to begin to program with directions.

6. Test the program logic with Internal Devices (Input and Output signals placed in the
FBD wiring area).

7. Simulate and check the programming logic without connecting an PneuAlpha Control-
ler. The user can:

     - force input signals ON/OFF 

     - change function parameters (timers, counters, analog data, etc.)

     - display comments or function values on screen

     - Monitor component status via wire colors (ex. Red Wire = OFF, Blue Wire = ON) 

8. Read information from an PneuAlpha Controller and recreate the Program on the FBD

           base.

9. Monitor an PneuAlpha Controller that is in operation.

10. Print the FBD screen and component information shown on screen.
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4.3 The System Sketch Monitor Screen

 

The System Sketch Screen is a simple drawing window. System sketch is useful to give the
pictorial view of I/O devices which are connected to the Controller and the programming logic.

 The following operations can be performed in System Sketch.

1. Draw a diagram using the drawing tool bar.    

2. Place the I/O devices and Function Blocks to represent the Controller set-up.

3. Place OLE components in the System Sketch window.

4. Monitor/test an operational controller.

5. Simulate and check the programming logic without connecting the actual controller.

6. Print the System Sketch Screen and the components information contained in the
screen.

7. Import Bitmap Images.
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4.4 The Programming Mode

 

This is the mode in which all programs are created and system components added or deleted.
Also known as the Drawing mode, all the toolbars and the menu options will be enabled for
programming or drawing. The FBD window and System sketch windows will default to the Pro-
gramming mode when files are created or opened. The indication title will be displayed as
“FBD” in the FBD base and as “Monitor in System sketch” in the System sketch window.

 

4.4.1 The FBD base in Programming Mode

 

As the name suggests, all the functions necessary to build a program can be accomplished in
the programming mode. The user may add FBs or other signals, set or change parameters,
move components, and perform wiring operations in the programming mode. (See Chapter 6
for more details.)

The Auto Wizard Function is also available in this mode. The main purpose of Auto FBD Wiz-
ard is to educate inexperienced users so that they can get acquainted with Signals, Function
Blocks, Wiring and related programming items. 

 

4.4.2 “Monitoring in System Sketch window” in the Programming Mode

 

The user is allowed to add, modify, move, and resize the drawing objects in System sketch
window.  Use the Accessories Tool bar to add components as in the FBD base.  Copy compo-
nents to or from the FBD base.  Select any component in the window by pressing the mouse
left button and drag the object to the desired location. Double click on a Function Block to open
the parameter setting dialog.

Objects can be drawn via the Drawing Tool bar with the Line, Oval, and Rectangle commands
and/or import objects with the commands in the Insert Menu.   

 

4.5 The Simulation Mode

 

The Simulation mode will mimic the conditions under which a program is run without hooking
up any of the actual hardware. This can be a very powerful tool for debugging programs prior
to writing the contents to an actual target controller.

The information generated by the program will be continuously read from the Simulator. The
On/Off status and current values of the Signals and Function Blocks will be updated by the
SMC VLS software or the user can input values for simulation purposes. The user can control
the On/Off state of Inputs with the click of a mouse and can directly set analog values.

 

4.6 The Monitor Mode

 

The Monitor Mode can monitor and test the actual target controller hardware which is con-
nected to the PC through an RS232 interface. The information regarding state and current
value of Signals and Functions will be continuously read from the target controller and updated
accordingly in the SMC VLS software.

If the controller contents are updated via the controller front panel keys, a message box will
pop up stating that the controller contents are updated and monitoring will be stopped. The
application will automatically switch to Program mode.

 

4.7 Cable Connection

 

The ECC-PNAL-232CAB cable is used to connect the PneuAlpha controller and the PC or
modem.
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5. Menu Bar Functions

 

This chapter gives a brief description of the functions available in the Pull Down menus avail-
able on the top edit bar.   

 

5.1 File

 

New (Crtl+N) - Creates a new file with windows in both the FBD and Monitoring in System
Sketch window. Any file currently open will be closed with an option to save.

Open (Crtl+O) - Open an existing file with windows in both the FBD and Monitoring in System
Sketch window. Any file currently open will be closed with an option to save.

Close - Closes existing active documents in both the FBD and System Sketch window with an
option to save any changes.

Save (Crtl+S) - Saves the current file to its current name and directory.

Save As - Save the current file under a new name and or directory. The first time a file is saved
this command will come up so that the file can be named.

Print Setup - Select a printer and printer connection from the Print Setup Dialog Box that pops
up on the screen.

Print Preview - View the active document as it would appear if printed. This command is dis-
abled if either of the FBD or Monitoring in System Sketch window is minimized.

Print (Crtl+P) - A Print Dialog box pops up onscreen to select options and Print data.

1 “Previously Opened File” - Use the numbers and filenames listed to Open the last eight
documents that have been closed.

2 “Next to Last File Opened” - See above.

Exit - End the VLS session.  A prompt will appear to save open documents.

 

5.2 Edit

 

Undo (Crtl+Z) - Cancel the Previous Instruction.  There is only one level of Undo available.  

Redo (Crtl+Y) - Cancel the Previous Undo Instruction.  There is only one level of Redo
available.

Cut (Crtl+N) - Remove the selected data from the Screen and place it to the Clipboard.

Copy (Crtl+C) - Copy the selected data on the Clipboard.

Paste (Crtl+V) - Add the data from the Clipboard to the Program

Delete (Del) - Delete the selected data from the program.

Select All (Crtl+A) - Select All the function blocks on the screen.



 

α

 

 PneuAlpha

 

Menu Bar Functions 5

 

5-2

 

5.3 View

 

Close System Sketch - Close the System Sketch Screen. If the screen is closed, the title will
change to Open System Sketch.

Close FBD - Close the Function Block Diagram base. If closed, the menu option will change to
Open FBD.

Standard Tool Bar - When the Check mark appears, the Standard Tool Bar will be displayed
onscreen. 

Controller Tool Bar - When the Check mark appears, the Controller Tool Bar will be displayed
onscreen.

Drawing Tool Bar - When the Check mark appears, the Drawing Tool Bar will be displayed
onscreen.

Accessories Toolbar - When the Check mark appears, the Accessories Tool Bar will be
displayed Onscreen.

Wiring Toolbar - When the Check mark appears, the Wiring Tool Bar will be displayed
onscreen.

Status Bar - When the Check mark appears, the Status Bar will be displayed Onscreen.

Zoom - Choose from 200, 150, 100, 75, 50, 25, or 10% zoom factor

 

5.4 Insert

 

Icons into Vacant Terminals - Input S and Output S icons will be inserted into any vacant Input
or Output Terminals, respectively.

Insert New Object - Insert a Display, OLE, or file into the System Sketch Window.

Links... - Edit links between the SMC VLS file and other documents.

Object - Opens the application in which the selected embedded or linked object was created
so that you can edit it.

 

5.5 Tools

 

Start Auto FBD Wizard - The Auto FBD Wizard is an option to help explain function blocks and
the way in which they will perform under differing combinations and placements. 

Renumber Signals - The Function Blocks will be renumbered to the lowest possible number. If
Function Blocks have been deleted, the higher numbered Function Blocks will decrease
their value to the lowest number available.

Clear Controller Contents - Clears the memory of the controller that is connected to the PC.

 

5.6 Search

 

By Comment - Search for a Function Block by the attached comment.   The comment does not
have to be displayed nor is the search case sensitive. The text, however, must be an exact
match. If a match is found, the block will be highlighted.

By Signal Number - Search for the Function Block by the coded signal number. The alpha-
numeric sequence as it appears onscreen - one letter followed by two numbers. The let-
ters are not case sensitive. Ex. - M01, i06, B12.
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5.7 Controller

 

Write to Controller - Write the program in the SMC VLS software to the memory of the control-
ler. The contents of the controller memory will be overwritten.

Read from Controller - Transfer the contents of the controller memory into the SMC VLS pro-
gram. The current program in SMC VLS will be overwritten.

Verify Controller data with SMC VLS - Verify that the data in the FBD matches the data in the
controller memory.

Diagnosis of Controller - Brings up a dialog box with the following information about the
controller: 

• Model name of the connected Hardware

• Version number of the connected hardware

• Number of input terminals connected to the controller

• Number of analog inputs

• Number of output terminals

• Power supply type (AC or DC)

• Error Code which the target controller has

• Status of the RTC

• Status of the controller (Run or Stop)

• Status of Program Write (Enable or Disable)

Simulation - The simulation mode will run the program in the SMC VLS memory without a con-
troller. This is very useful to check your program prior to transferring it to the actual con-
troller.

Drive Controller - Place the connected PneuAlpha

 

 

 

controller in Run or Stop mode from the
SMC VLS  software.

Monitor/Test - Monitor the status of the connected PneuAlpha

 

 

 

controller from the SMC VLS     

       software.

Select COM Port - Select from Com port 1, 2, 3, or 4 for your PC to controller connections.

 

5.8 Com

 

Configuration - Set the Configuration of the COM port. The user can choose between a
modem or a Com port to communicate with the Controller.

Connect Line - Dial a Telephone number by invoking the Ring Telephone dialog .

Disconnect Line - Disconnect an ongoing call.  An active Modem line should be disconnected
before it can be used again for communication.
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5.9 Option

 

Select Controller Type - Select the type of controller that the program for which the program is
to be written - 4 Inputs and 2 Outputs, 6 Inputs and 4 Outputs, or 12 Inputs and 8 Outputs.

User Defined Icons - Import your own user defined Icons.

Function Set Icon - Select the icon set to be displayed on screen.

Set Wire Color - Set the wire color for the Edit and Simulation modes.

Set FBD Base Color - Set the Function Block Diagram Base color.

Change RTC Current Time - Change the RTC current time.

Date Format - Select one of the following formats in which the calendar date will be shown.
mm/dd/yy,  dd/mm/yy,  yyyy/mm/dd.

 

5.10 Window

 

Cascade - Use this command to arrange multiple opened windows in an overlapped fashion.

Tile - Use this command to vertically arrange multiple opened windows in a non-overlapped
fashion.

1 Monitoring in System Sketch - Open the system sketch window for monitoring/editing.

2 FBD - Open the Function Block Diagram base for monitoring or editing.

 

5.11 Help

 

Contents - Shows the Table of Contents of the Help Function. the user can click on the desired
chapter and the help file will pop up onscreen.

Search for Help on... - Displays the opening screen of the Help command. Choose froma list of
instructions and reference information on the features of the SMC VLS software.

How to Use Help - Provides information on how to use and customize the help function. 

About VLS... - Gives the Version number and Copyright notice of your copy of SMC VLS.
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6. Function Block Diagram (FBD) Operation

 

6.1 Opening a New File

 

To open the SMC VLS software, press the “Start” icon in the bottom left corner of the monitor
display. Enter “Programs\SMC PneuAlpha Controller\Alpha Programming”. When the SMC
VLS programming software is loaded, begin a new program by either clicking the New option
under File Menu or by clicking on the New file icon. Select the appropriate I/O configuration for
the controller from the box appearing onscreen.

Open an existing file with the “Open...” command under File or by clicking on the Open icon. A
list of the current SMC VLS files contained in the Prog default folder will appear. Choose a file
from this folder or browse and open a file in another location.

 

6.1.1 FBD Base Resize

 

When FBD window is opened, it has a minimum size. The Base can be re-sized in width or
height by dragging either the right or bottom edges respectively. By dragging the right-bottom
corner of the base rectangle, the base height as well as width changes. The Base cannot be
re-sized on the left and top edges.

When the right edge of the base is changed, output rectangles, components, and wiring con-
nected to the output rectangles move with the base.

When the Base size is reduced, all the block items along with wiring present in that area are
moved inward. The Base size can be increased to a scroll bar position limit of 30,000.

 

6.1.2 FBD Base Color

 

The FBD base color can be changed in the “Set Base Color” command in the Options Menu.
Choose from 48 colors available on the palette or define your own color.
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6.2 The Program Edit Mode - Begin to Program

 

Programs for the PneuAlpha

 

 

 

controller can be created and edited from the Program Edit
Mode. Program Edit is the default mode for the SMC VLS software. The PneuAlpha is pro-
grammed by placing items on the FBD Base and connecting the various components together
with the wiring analyzer. There are five types of system components that can be placed on the
FBD base. A short description of the function and placement locations possible for the various
components follows.

 

6.2.1 Inputs

 

System Inputs receive data from the devices wired to the actual controller and
can be either the digital or analog signal type. The digital units transmit an On
or Off signal; Analog inputs transfer a data value. The icons can be found under
the IN heading of the Accessories Toolbar at the left of the FBD base.

The digital signals can be placed on the Input rectangles at the left of the FBD
base or on the base itself. Each icon functions in the same way.  The different
icons have been developed to aid in the documentation and understanding of
the program. Use an input icon that corresponds to the actual input device to
be connected to the controller. The names of the signals will appear when the
mouse arrow is placed on the icon.

The analog signals can be placed only in Input Rectangles I01 - I08. The con-
troller inputsact as an 8 bit Analog/Digital converter when the analog signal is
placed in the Input Rectangles.

 

6.2.2 Front Panel Keys

 

There are eight signals that correspond to the front panel keys and these sig-
nals may be used as additional digital inputs. These are the ESC, OK, “+”, “-”,

, ,  and  keys. Press the front panel keys while the PneuAlpha controller
is in Run mode to active the signals.

These keys may be placed only on the FBD Base and can be found in the IN
heading of the Accessories Toolbar. The names of the signals will appear
when the mouse arrow is placed on the icon.

 

6.2.3 System Memory Bits

 

These five System Memory bits act as digital inputs and can be placed on the
FBD base only. The memory bits have the following set functions.

M01: Always ON

M02: Always OFF

M03: Cycles between 0.5 seconds On and 0.5 seconds Off

M04: Turns On when there is a Real Time Clock Error

M05: Turns On when the SummerTime clock is On.

These keys can also be found under the IN heading of the Accessories Toolbar. The names of
the signals will appear when the mouse arrow is placed on the icon.
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6.2.4 Function Blocks

 

There are twenty-two function blocks that can be used with the PneuAlpha controller. They fall
into two categories - Logic and Standard. The function blocks can be placed on the FBD base
only.

 

6.2.5 The Logic Blocks

 

The six Logic Blocks - AND, OR, NOT, XOR, NAND, NOR - can receive only
digital inputs. These blocks turn their Output on depending on the ON/OFF
conditions of their Inputs. Please see the Help File for a detailed description of
each block. 

The Logic Blocks can be found under the LOGI heading in the Accessories
Toolbar. The names of the blocks will appear when the mouse arrow is placed
on the icon.

 

6.2.6 The Standard Function Blocks

 

The sixteen Standard Function Blocks include the BOOLEAN, SET/RESET,
DELAY, ONE SHOT, PULSE, FLICKER, ALTERNATE, COUNTER, UP/DOWN
COUNTER, COMPARE, TIME SWITCH, OFFSET GAIN, DISPLAY, ZONE
COMPARE, SCHMITT TRIGGER, and the HOUR METER. Please see the
Help file for a detailed description of each block.

The Standard Function Blocks can be found under the FUNC heading of the
Accessories Toolbar. The names of the blocks will appear when the mouse
arrow is placed on the icon.

 

6.2.7 Placing the Blocks on the FBD Base

 

To place the Function Blocks or Signals on the FBD base, left click once on the icon and move
the mouse to the desired location for the icon to be placed. The arrow should turn into a
crosshair when pulled over the FBD base border. Left click to install the icon.

An ERROR dialog box will appear to detail any errors in block placement.

 

6.2.8 Moving Function Blocks and Signals

 

Function Blocks and Signals can be moved after they have been placed on the FBD base by
left clicking on the icon and dragging the icon with the left button depressed. When the left but-
ton is released, the icon will be dropped in the new position. Blocks can only be moved inside
the FBD base. Wiring connections will move with the icon.

Illegal operations will be explained via a dialog box and the icon will be returned to its previous
position.
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6.3 The Wiring Tool

 

The wiring tool graphically represents, in the form of terminated lines,
the connections made between the pins of inouts, outputs, signals and
functions  present in the FBD window.

 

6.3.1 Input and Output Pins

 

The small icons present on left and right side of Signal/Function icon are known as pins. Pins
are of two types, BIT (Digital) pins and WORD (Analog) pins. Pins which are present on the left
side of icon are known as INPUT pins. Pins which are present on the right side of icon are
known as OUTPUT pins.

 

Bit Pin (Digital Pin)

Clear Pin (Also a Digital Pin, but with a specifiic purpose)

Word Pin (Analog Pin)

 

6.3.2 Connecting Functions and Blocks

 

Wiring tool can be invoked by clicking the Wiring Toolbar. The controller supports up to 999
wires in FBD window. The user can draw wires using the following steps:

1. Press the Left mouse button at the pin position at which wiring should start.

2. Drag the mouse keeping the Left mouse button pressed to the destination pin.

3. Release the Left mouse button.

 

Digital Output Pins can be connected to Digital Input Pins and Analog Output Pins can be con-
nected to Analog Input Pins. Digital pins cannot be connected to Analog pins. Output Pins can
connect to multiple input pins.

 

In the following cases an appropriate error message occurs:

Input Pin cannot be connected to Input Pin.

Output Pin cannot be connected to Output Pin.

Digital Pin can not be connected to Analog Pin.

Input Pin can not have more than one wire connected to it.

No pin is located in this position.

Wiring will be activated until the user presses the left mouse button on any other tool bar or on
some vacant space in the FBD base. The user can move wires with the mouse by clicking and
dragging them to a new location.

Bit Pin Word Pin

Clear Pin
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6.4 Setting Up Function Block Parameters

 

Function block parameters can be viewed by double clicking on the Function Block . A dialog
box will pop up that shows the parameters that can be adjusted and a comments section for
easy documentation. 

 

6.4.1 Signals and Logic Blocks

 

The signals (Input, Output, M bits, and Keys), Logic Function Blocks (AND, NAND, OR, NOR,
XOR and NOT) and the ALTERNATE Function Block do not have adjustable parameters. The
dialog box for these components will contain a comment box, the Display comment check box,
and the Display Signal Number box.

The Comment Edit box is used to enter a comment which will be displayed on the top of the
icon. This can be up to 256 characters but only 16 characters will be considered for display.

The Display Comment box will display the comment only when checked.

Similarly, the Display Signal Number box will display the signal number next to the icon if
checked.

 

6.4.2 The Function Blocks

 

Each Function Block has its own set of Parameters that
may be set including the Comment, Display Boxes listed
above. Each block has a help function to guide the user
through the options if necessary.

If using the slider portion of the parameter settings, the
value can only be set from 0 - 100. If entering the digits in
the box, the listed maximum tolerances can be entered.



 

α

 

 PneuAlpha

 

Function Block Diagram (FBD) Operation 6

 

6-6

 

6.5 The Function Block Wizard

 

The FBD Wizard is a tool to learn function block program-
ming. It can guide the user through simple program setups
and is especially good at showing how different combina-
tions of function blocks relate with each other. The Wizard
allows the user to pick the desired components in a circuit
(Inputs, Outputs, and Function Blocks) and demonstrates
how the components work together. The Function Blocks
can be placed in different sequences, program parameters
can be set, and the circuit operation simulated. If the
proper result is achieved, the Wizard can transfer the cir-
cuit to the FBD base. Open the Function Block Wizard with
the icon or the Start FBD Auto Wizard option in the Tools
Menu.

There are eight steps in the Wizard’s setup program. The
user can proceed forward and backward along this line.
Each step is accompanied by a guidance box that will
bring up instructions in a dialog box.

The Wizard is a learning tool and does not possess the full capabilities of programming on the
FBD Base.  The Wizard is best used with simple schematics as the number of programming
options can grow quite large.

 

6.5.1 Choose an Output

 

The output icons will appear on the left of the screen and the Output rectangles will appear on
the right of the screen. Choose an icon with the left mouse button and place it in the Output
rectangle with another click of the button. Proceed to step two by clicking on the Next box.

 

6.5.2 Choose Function Blocks

 

A list of function blocks appears on the screen from which up to four total blocks can be cho-
sen to place in the circuit with the output. The Function Blocks that can be selected are the
Set/Reset, Alternate (ALT), One Shot, Delay, and the Flicker. Choose the box with the “?” mark
in the middle to find out more information on a particular function. Check the box at the far left
to select the function block for the circuit.

 

6.5.3 Choose Additional Function Blocks

 

An additional list of Function Blocks is available which contains the Counter and the Compare
blocks. If too many function blocks are chosen, an error message will appear. Functions can
be removed by clicking on the left hand box again to remove the check mark. To move back to
previous menus, click on the “Back” box.

 

6.5.4 Select Signal Order

 

The Wizard will show the possible combinations of Functions Blocks. A pictorial representation
will appear at the top of the screen and the function block icon connection will be shown below.
Use the Up and Down arrow keys to scroll through the possible combinations. Depending
upon the number and type of Function blocks chosen, dozens of possible combinations will
show onscreen. The first combination will be chosen as a default if no selection is made.

 

6.5.5 Adding a Logical Condition

 

Choose to have the output conditions driven by input signals or to have them continuously
driven. Depending upon the Function blocks chosen, different option boxes will be enabled.
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6.5.6 Select Signals to Drive Functions

 

Select the Input Signals to drive the chosen function blocks. Click on the input icon with the left
mouse button and place it in the Input rectangles on the right side of the screen. Outline the
box in blue by clicking on it with the left mouse button to activate it for the next screen. Signals,
Outputs, or Time Switches can also be chosen to be used as inputs for the next screen.

 

6.5.7 Setting Parameters

 

Set parameters for the Function Blocks and set up Logic functions for the Boolean parameter
in this screen. A red arrow will appear above the Function Block that should have its parame-
ters set next.

Double click on the Function Block to open the parameter dialog box and enter the parameters
as required. A Boolean Function Block will always appear in this screen to enable the user to
employ Logic Operations. The logic must be set for the Boolean operation.  (The logic can be
set so that the whenever the input is On, the Boolean Block is On.  This makes the operation of
the Boolean function transparent).

The logic can be set two ways - the Set Rule or
the Set by Logic option. Set Rule allows the
user to set the signals in as many non-conflict-
ing options as desired and the logic will be gen-
erated by the SMC VLS software. Click on the
signals and function blocks to turn the device
On or Off and accept with the Set Rule button
when finished. Set as many Rules for each sit-
uation as necessary.

The Set by Logic option allows the
user to write a logic equation using the
AND, OR, XOR, NOT, and operands.

 

6.5.8 Operation Check

 

Check the operation of the circuit by turning the Input Signals On and Off. The status of the
outputs and the current and set values for each block will be displayed. The wire connected to
an output pin which is On (Signal or Function Block) will change to a red color.

When finished with the operation check, press the Finish button to place the completed circuit
on the FBD base or Cancel to return to the FBD base in its original condition.
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6.6 Simulation Mode

 

The simulation mode allows the user to test the actions of the program prior to transferring the
program to an PneuAlpha controller. Changes to Function Block parameters can be made dur-
ing the simulation process, analog values can be input as necessary, and the input signals
themselves can be turned On/Off. 

This is a powerful tool to debug new programs or to check updates to current programs.

 

6.6.1 Entering the Simulation Mode

 

When the program is ready to be tested, enter the Simulation mode by clicking on the Simula-
tion icon or by using the Simulation Start option in the Controller Menu. The FBD base or the
System Sketch Monitoring Screen can be viewed as required.

The digital wire connections will change color so that outputs pins that are On will become red
and output pins that are off will become blue. (These colors can be changed in the Options
menu when in the Programming Mode). The components will all be labeled with their number
(I01, B02, O02, K08, etc.), On/Off status, timer values, counter values, Priority Settings, and
other parameter values. At a glance, all the important information about each component is
displayed.

 

6.6.2 Turn Signals On/Off

 

Input and Key Signals can be turned On/Off by single clicking on the icon to be adjusted in the
FBD Base. System Memory (M) bits cannot be manipulated or used while in the simulation
mode.

 

6.6.3 Change Function Block Parameters

 

Function Block parameters can be changed by double clicking on the function block. Change
the parameters as desired and click the OK box to accept. The new values will be shown
onscreen and any change to the program settings will be performed. The TimeSw cannot be
edited during the Simulation mode.

 

6.6.4 Force Outputs On/Off

 

Outputs can be forced On/Off momentarily but the existing program parameters will overwrite
the force at the next program scan. The force will be in effect long enough to active a Pulse,
Set/Reset, or other trigger related signal.

 

6.6.5 Inactive Functions during Simulation Mode

 

The File, Edit, Insert, and Tools Menu will be deactivated along with the Accessories, Wiring,
and Drawing Toolbars. No program editing in regards to adding, deleting, wiring, or moving any
system components can take place while in Simulation Mode.

 

6.6.6 Exiting the Simulation Mode

 

To exit the Simulation mode, press the Simulation icon with the mouse left button or use the
Simulation Stop Command in the Controller pull down menu.
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6.7 The Monitor Mode

 

The Monitor Mode can be used to monitor the current conditions of an PneuAlpha controller
that is running a program. The PneuAlpha controller must be connected to the PLC via the
ECC-PNAL-232CAB cable and running or, when Monitor Mode is started an error dialog box
will appear.

The contents of the SMC VLS memory and the PneuAlpha controller memory must be the
same before   monitoring can take place. The SMC VLS package will read the contents of the
PneuAlpha controller continuously and update the information accordingly. Changes made to
program parameters will be transferred to the controller and will affect the operation of the
equipment.

 

6.7.1 Entering the Monitor Mode

 

Enter the Monitor Mode by clicking on the Monitor Icon or by using the Monitor Start command
in the Controller Menu. 

Like the Simulation Mode, the digital wire connections will change color so that outputs pins
that are On will become red and output pins that are Off will become blue. (These colors can
be changed in the Options menu when in the Programming Mode). The components will all be
labeled with their number (I01, B02, O02, K08, etc.), On/Off status, timer values, counter val-
ues, Priority Settings, and other parameter values. 

The controller status (RUNNING or STOPPED) will be monitored continuously and will be dis-
played.
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6.7.2 Turn Signals On/Off

 

Input and Key Signals can be forced On/Off momentarily but the existing program conditions
will quickly overwrite the force. The force will activate blocks that are time or count based (Alt,
Pulse, Counter, One Shot, Set/Reset, etc) but will not have an effect on Logic Blocks or Func-
tions that have an Input Signal that must remain ON (E.g. the Delay, Flicker, Display, Gain,
etc).

System Memory (M) bits cannot be manipulated in the Monitor Mode.

 

6.7.3 Change Function Block Parameters

 

Function Block parameters can be changed by double clicking on the function block. Change
the parameters as desired and click the OK box to accept. The new values will be shown
onscreen and any change to the program settings will be performed. TheTimeSw cannot be
edited during the Monitor mode.

 

6.7.4 Force Outputs On/Off

 

Outputs can be forced On/Off momentarily but the existing program parameters will quickly
overwrite the force. The force will activate blocks that are time or count based (ALT, PULSE,
COUNTER, ONE SHOT,...) but will not have an effect on Logic Blocks or Functions that have
an Input Signal that must remain ON (E.g.. the Delay, Flicker, Display, etc).

 

6.7.5 Inactive Functions during Monitor Mode

 

The File, Edit, Insert, and Tools Menu will be deactivated along with the Accessories, Wiring,
and Drawing Toolbars. No program editing in regards to adding, deleting, wiring, or moving any
system components can take place while in Monitor Mode.

 

6.7.6 Exiting the Monitor Mode

 

User can stop the Monitoring and switch to Program Mode either by clicking the Monitoring
button present in the Controller tool bar or by selecting the Monitor/Test Stop command in the
Controller Menu.

If during the course of monitoring the controller contents are updated using the front panel
keys, a message box will appear stating that controller contents are updated and monitoring
will be stopped. The application will automatically switch to Program mode.



 

α

 

 PneuAlpha

 

System Sketch Screen Operation 7

 

7-1

 

7. System Sketch Screen Operation

 

‘Monitoring in System sketch’ is a simple graphics window. System sketch is useful to give the
pictorial view of I/O devices which are connected to the Controller and the associated pro-
gramming logic. When the Monitoring in System sketch window is active, the Wiring tool bar
will be disabled.

The System sketch screen user can draw their own diagrams, place I/O devices to represent
the Controller set-up, import OLE files, monitor a running PneuAlpha controller, simulate/check
programming logic without a controller, and print System sketch screen data.

 

7.1 Components of System sketch window

 

The System Sketch Window has a default rectangle known as the System Sketch Base Rect-
angle. All the components should be placed within the System Sketch Base Rectangle.

 

7.1.1 System sketch Base Resize

 

The System Sketch Window opens to a minimum default size. The Base can be resized in
width or height by dragging either the right or bottom edges respectively. By dragging the right
bottom corner of the base rectangle, the base height as well as width changes. The Base can-
not be resized on left and top edges.

Components present in the System Sketch Window are not moved when base is resized.
Hence the Base can be re-sized only till the edge of right most or bottom most component.
Base size can be increased to a scroll bar position limit of 30,000.

 

7.1.2 Changing the Base Color

 

Choose a new Base Color from the shades available in the Set Base Color command in the
Options Menu.

 

7.1.3 Drawing Lines, Ovals, and Rectangles

 

Lines can be drawn by clicking on the line icon and then moving the mouse to place for the line
to start. Click the mouse button to start the line and release the button when the desired end
point is reached.

Ovals and Rectangles can be drawn in the same manner by choosing the appropriate icons.

 

7.1.4 Moving and Resizing Lines, Ovals, and Rectangles

 

The objects can be moved within the System Sketch base size limit by clicking on them and
dragging them to the new position. Resizing can be done by pressing the left mouse button on
any of the edges and dragging the mouse. The mouse cursor changes to double headed arrow
when it is moved over the edges indicating the direction in which Resizing can be done.

The objects can be Resized within the boundaries of the System sketch base only.

Cut, Copy, and Paste can be performed on these objects within the System Sketch window.
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7.1.5 Changing Colors 

 

To change the color of an existing line, select the line with the left mouse button. Click on the
Line Color Icon and choose the new color for the line. Future Lines will be drawn in this color.

This color will appear as the Line color for the outside of Ovals and Rectangles. The inside
color of the Rectangle and the Oval can be changed by clicking on the Brush Color icon and
choosing a new color.

 

7.1.6 Changing the Line Width

 

An existing Line width can be changed by selecting the Line in the System Sketch Window and
clicking the desired line width - thin, medium, or thick. The line width for Ovals and Rectangles
is changed in the same manner. This will now be the active Line width for all the drawing tools.

 

7.2 Insert an LCD Display

 

The LCD Display can be inserted into the System Sketch Window by either using the insert
window or during Simulation or Monitoring. 

 

7.2.1 The Insert Menu

 

There must be an existing Display in the FBD base for the Insert LCD command to be acti-
vated in the Insert Menu. Click on the command to insert the LCD screen onto the System
Sketch Window. If it is already present in System sketch window, an error dialog box will
appear.

 

7.2.2 Simulation and Monitor Mode

 

A Display function block will cause a dialog box to appear upon entering Simulation or Monitor
Mode. This box will give a prompt for whether to add the Display to the System Sketch Window
base. Check yes to automatically add the LCD Display. 
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7.3 Adding an OLE File

 

An OLE object can be inserted into the System sketch window. We can edit this object by dou-
ble clicking on it. The object can be moved within the System sketch base, and can be Resized
within the limits of the System sketch base size. The OLE Object can be inserted using Insert
New Object dialog box.

Select the type of information to be inserted into System sketch window. Some common object
types include graphs, reports, spreadsheets, bitmaps, and equations.

 

7.4 Adding a Signal or Function Block

 

Signals and Functions Blocks can be copied from the FBD base area or added with the Acces-
sories Toolbar. Analog Signals and Function Blocks must be copied from the FBD base. 

If a Function Block is copied from the FBD Base, its number is copied and the parameters will
be displayed when in the Simulation or Monitor Mode. Wiring connections cannot be copied to
the System Sketch window.

Items placed in the System Sketch window using the Accessories Toolbar will have new func-
tion block numbers assigned to them but these numbers will not affect the number of function
blocks that can be placed in the PneuAlpha controller’s Program. The Function Block can be
copied to the FBD base and then incorporated into the PneuAlpha controller’s program.

Move items with the mouse to any area inside the System Sketch base window.

 

7.5 The Simulation Mode

 

The Simulation Mode is very similar to the command in the FBD mode (See Chapter 6, section
6.6). The Simulation mode can be entered from the Controller Menu by using the Simulation
command.

The status of Signals and Function Blocks can be read from the System Sketch window as
well as Function Block parameters. Updates to Function Block values will be transferred to the
FBD base. Turn signals On/Off with a click of the mouse just as would be done in the FBD
base. There is no wiring to show status in the System Sketch Window.

Items that are added from the Accessories Toolbar will have no variable values unless they
have been copied to the FBD base and incorporated into the program. Their parameters can
be viewed and updated the same as other Function Blocks.
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7.6 The Monitor Mode

 

The Monitor mode can be entered from the Controller Menu by using the Monitor/Test com-
mand it is very similar to monitoring in the FBD base mode (See Chapter 6, Section 6.7). 

Only the status of Signals and Function Blocks contained in the PneuAlpha controller’s mem-
ory will display values in the System Sketch window. Updates to Function Block values will be
transferred to the FBD base and from there to the PneuAlpha controller. Force signals On/Off
momentarily with a click of the mouse just as would be done in the FBD base.

There is no wiring to show status in the System Sketch Window.
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Exit the Monitor function by clicking on the Monitor icon or by using the Monitor/Stop command
in the Controller Menu. If the memory contents of the PneuAlpha controller are updated with
the front panel keys, the Monitoring function will end.
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Under no circumstances will The SMC Corporation of Japan or it’s subsidiaries be
liable or responsible for any consequential damage that may arise as a result of the
installation or use of this equipment.

All examples and diagrams shown in this manual are intended only as an aid to
understanding the text, not to guarantee operation. SMC Corporation of Japan will
accept no responsibility for actual use of the product based on these illustrative
examples. 

Owing to the very great variety in possible application of this equipment, you must
satisfy yourself as to its suitability for your specific application.
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